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Abstract: In Nigeria, it is common to design buildings first for gravity loads and then assess the structure's suitability 
for safety against lateral loads. It is well known that lateral loads influence the design of multi-story buildings, hence 
the designer's first priority should be to ensure that the structure is sufficiently safe from lateral loads. Nigeria has a 
large number of RC frame building that are not designed to resist seismic load because of the belief that Nigeria does 
not have area that are prone to earthquake, but Nigeria is no longer free from earthquake due to the occurrence of 
earth tremors in Nigeria in the past. This study focused on the design of RC shear wall in three storey building that 
assume to be place in seismic prone area in Nigeria which is capable of resisting Earthquake. The data of the 
magnitudes of earth tremors that have occurred in Nigeria was collected from Centre of Geodesy and Geodynamic 
to determine the seismic load to EC8 specification. Extended Three-Dimensional Analysis of Building System 
(ETABS) was used to analyze and design the shear wall. ETABS 2016 software was incorporated with all the major 
analysis engines that is static, dynamic, Linear and non-linear, etc. This tool was used for the modeling, analyses 
and design of RC shear wall for three storey building to resist Earthquake load. Hence, providing shear walls at 
adequate locations substantially reduce structural vulnerability and absorb Earthquake energy through inelastic 
deformation and prevent collapse and lose of lives. 
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1. Introduction 
Following a string of recent earth tremors in various sections of the country, Nigerian seismologists 

unanimously concur that the country is no longer an earthquake-free zone (aseismic), as was formerly 
thought. In light of this scenario, steps must be taken to lessen the catastrophic consequences of a 
significant earthquake in Nigeria. 

Nigeria's history of earthquakes began in the 1930s, when small earthquakes were recorded in Warri 
in 1933 and in some areas of Ibadan on June 22, 1939, (Ananaba, 1991). Parts of Ile-Ife and Lagos were 
also affected by the 1939 incident, which was most likely connected to the Accra earthquake that day 
(Ajakaiye, et al., 1987). On December 21, 1963, at approximately 18:30 Greenwich Mean Time (GMT), 
another occurrence was observed at Ijebu-Ode, with an epicentral intensity of roughly V. The most 
widely publicized episode took place on Saturday, July 28, 1984, and it affected South-Western Nigeria's 
Ibadan, Ijebu-Ode, Shagamu, and Abeokuta. Ajakaiye et al. (1987) ascribed this to the fact that these 
regions are part of the Nigerian basement complex, which was previously believed to be tectonically 
stable. Many people in these places felt the tremor very intensely; trees and buildings shook, objects on 
shelves toppled, and the timing of the incident was recorded as 12:10 GMT.  

Nigeria is far from known world active plate boundaries. It is believed that it is not known to be 
seismo-genic but historical records and recent findings have shown that Nigeria may not be completely 
free from earthquakes (Adepelumi, 2009; Onuoha, 2010; Akpan & Yakubu, 2010). Since tremors were 
recorded in Nigeria in the past in the Ifewara—Zungeru fault zone (Figure 1), any future occurrences of 
Earth tremors in the country are likely going to occur along this fault zone which has been shown to be 
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linked with the Atlantic fracture system (Anifowose, 2010; Adepelumi, 2008; Olujide & Udoh, 1989.; 
Olorunfemi, et al., 1986) 

The National Agency for Science and Engineering Infrastructure (NASENI) in Abuja created the 
Nigerian National Network of Seismological Stations (NNNSS), which was moved to the Center for 
Geodesy and Geodynamics in Toro, Bauchi State, in 2006. NASENI built the Nigerian National Network 
of Seismographic Stations (NNNSS), now managed by the Centre for Geodesy and Geodynamics (CGG) 
in Toro. CGG has been tracking earthquake activity in Nigeria since 2006. Figure 2, shows the different 
seismic stations in Nigeria (Afegbua, 2011). 

 
Figure 1. Map of Nigeria showing the Zungeru-Ifewara fault (Akpan & Yakubu, 2010). 

 
Figure 2. Distribution of seismic stations. The blue triangles represent those stations that are operational 
whilst the yellow triangles indicate the proposed stations. 

It is possible to minimize the potential risks to humans and damage potential to structures by using 
ground motion records from past earthquakes and advanced technologies that make it nearly possible to 
predict earthquake, ground motion with proper understanding of seismic sources and properties of 
seismic waves. A consequent lateral force or horizontal ground motion action that is comparable to the 
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impact of a horizontal force operating on a building is known as seismic load. Structure engineers are 
concerned about building safety and provide RC shear walls or other structural elements to withstand 
seismic loads. The RC Shear walls, in addition to slabs, beams, and columns, are reinforced concrete 
structures that resemble vertical plates. Usually beginning at the foundation, these walls run the length 
of the building. They can range in thickness from 150 mm to 400 mm in high-rise structures. This study 
focused on the design of RC shear wall in three storey building that assume to be place in seismic prone 
area in Nigeria which is capable of resisting Earthquake.   

2. Materials and Methods 
2.1. Basic Properties of Concrete  

Concrete has many microcracks, particularly where the mortar and coarser grains meet. This 
characteristic is essential to concrete's mechanical behavior. These microcracks spread during loading, 
which results in volume expansion close to failure and nonlinear behavior of the concrete at low stress 
levels. (Chen, 1982; Penelis & Kappos, 1997; Paulay & Priestley, 1992) provide an overview of such 
attributes. 

2.2. Response to Monotonic Loading and Modulus of Elasticity 
Tests on cylinders of different concrete grades produced the curve of concrete stress σc versus strain 

ε for monotonic compression, which is displayed in Figure 3. Figure 3 shows that the curve has three 
components (Chen, 1982): 
1. The cracks that were present in the concrete prior to loading essentially stay the same for stresses 

in the area up to roughly 30% of the concrete's maximum compressive strength fc. 
2. Because of stress concentrations at the crack points, bond cracks begin to spread at stresses between 

30 and 50 percent of fc.  
3. Some fractures at adjacent aggregate surfaces begin to bridge as mortar cracks at stresses between 

50 and 75 percent of fc. Other bond cracks, meanwhile, are still steadily expanding. Critical lengths 
of the biggest cracks are reached at compressive loads greater than approximately 75 percent of fc.  

 
Figure 3. (a and b) Stress-strain diagrams from cylinders of concrete subjected to uniaxial compression 
(a) for various concrete grades (Chen, 1982) and (b) a sketch used in concrete design. 

The Eurocode 2 (Eurocode, 2004) stress-strain diagram for uniaxial compression is shown in Figure 
3b. The maximum compression strength is denoted by fc, the strain at fc is denoted by εc1, and the 
ultimate strain is denoted by εcu. The maximum useable strain for concrete is defined by Eurocode 2 
(EC2) as εcu = 0.35%, with the supposition that no stress reduction occurs up to this degree of 
deformation. A compression strain of 0.4% is advised for seismic loading (Paulay & Priestley, 1992). 

In addition, the modulus of elasticity (Figure 3b) that is used in design is also influenced by the 
aggregates' characteristics and other mix design and environmental factors (CEN, 1991).  

In EC2 the modulus of elasticity is defined by a line between σc = 0 and σc = 0.4 fc (see Figure 3b) or 
Ec = 9500 (fck + 8)1/3.  

For design purposes, EC2 presents Poisson's ratio as 0.2, but if cracking is allowed for concrete in 
tension, Poisson's ratio may be assumed to be zero. Ec and fck are in MPa Poisson's ratio, v of concrete 
under uniaxial compressive loading that ranges between 0.15 and 0.22 (Chen, 1982). fck is the 
characteristic compressive cylinder strength, which is defined as the value of strength below which 5% 
fractile. 

𝑓𝑓𝑡𝑡  = 0.3(fck)2/3  
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where, 𝑓𝑓𝑡𝑡 and 𝑓𝑓𝑐𝑐𝑐𝑐 are in MPa. 

2.3. Reinforcing Steel Bars 
The stress (σs)-strain (εs) graphs for different steel grades are subjected to monotonic tensile loading 

in Figure 4. These figures make it evident that steel's ultimate deformation diminishes with increasing 
strength, a tendency that is comparable to—but more pronounced than—that of plain concrete. 
Furthermore, the ratio of yield stress (fy) to maximum stress (fu) rises with steel grade; in other words, 
strain hardening has a greater effect on high strength steel, whose hardening branch threshold is near the 
yield strain, than on low strength steel. 

  
Figure 4. Stress-strain diagrams for steel bars of various grades (Penelis & Kappos, 1997). 

2.4. Load–Lateral Force Method of Analysis 
Under a set of lateral forces applied independently in two orthogonal horizontal directions, x and y, 

a linear static analysis of the structure is carried out using the lateral force method. The goal of these 
forces is to replicate the peak inertia load that the horizontal component of the seismic activity induces 
in the x and y directions. This approach has long been and continues to be the mainstay of practical 
seismic design since structural engineers are accustomed to and have expertise with elastic analysis for 
static loads (caused by gravity, wind, or other static actions).  

EC8:4.3.3.2.1(1) P states that buildings whose response is not substantially impacted by contributions 
from vibration modes higher than the basic mode in each primary direction can use the lateral force 
approach. In the two primary directions, the fundamental period of vibration, T_1, need to be less than: 

𝑇𝑇1 ≤ ∑2𝑠𝑠
4𝑇𝑇𝐶𝐶 (1) 

where Tc = 0 is found in EC8, and the building shall meet the criteria for regularity in elevation, given in 
EC8: 4.2.3.3. 

According to EC8: 4.3.3.2.2, the seismic base shear force,𝐹𝐹𝑏𝑏 for the horizontal direction. 

𝐹𝐹𝑏𝑏 = 𝑆𝑆𝑑𝑑(𝑇𝑇1).m.𝞴𝞴 (2) 

where: 
𝑆𝑆𝑑𝑑 (T1) is the ordinate of the design spectrum at period T1. (See EC8: 3.2.2.5) m is the total mass of 

the building computed in accordance with EC8:3.2.4(2)¸ 𝜆𝜆 is the correction factor. Here, 𝞴𝞴 = 0:85 if T1 <
 2Tc and the building has more than two stories. 

𝑇𝑇1 can be approximated as follows: 
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𝑇𝑇1 = 𝐶𝐶𝑡𝑡𝐻𝐻3/4 and 𝐶𝐶𝑡𝑡 is a constant (3) 

where 

𝐶𝐶𝑡𝑡= 0.075
�𝐴𝐴𝑐𝑐

 (4) 

Ac for a concrete shear wall is the total effective area of the shear wall. 
Ac is given by the equation: 

Ac =∑(𝐴𝐴𝑖𝑖.(0.2 + (𝑙𝑙𝑤𝑤𝑤𝑤/H).2) (5) 

where Ai is the effective cross sectional area of the shear wall in the first storey of the building in 𝑚𝑚2. 
𝑙𝑙𝑤𝑤𝑤𝑤  is the length of the shear wall in the  first storey in the direction parallel to the applied forces, in 

m, H is the height of the building, in m, from the foundation or the top of the rigid basement And 𝑙𝑙𝑤𝑤𝑤𝑤= 
H should not exceed 0.9. 

Load Distributions  
The way the base shear is distributed over the height of the building, EC8 permit the assumption of 

deflection shape is linear. With this assumption, the inertia force generated at a given storey is 
proportional to the product of the storey height mass and its height from base. (See EC8: 3.6.3.1, 3.6.3.2 
or 3.6.3.3). Equation 4.11 in EC8 therefore gives the force on storey k to be: 

𝐹𝐹𝑘𝑘 = 𝐹𝐹𝑏𝑏 𝑍𝑍𝑘𝑘𝑀𝑀𝑘𝑘
∑𝑍𝑍𝑗𝑗𝑀𝑀𝑖𝑖

 (6) 

2.5. Extended Three-Dimensional Analysis of Building System (ETABS) 
ETABS is a special-purpose computer program developed specially for building structures 

(Anjaneyulu & Prakash, 2016). It is currently the most popular design software available. This study, 
primarily focuses on the design and comparative analysis of a reinforced concrete shear wall structure 
using ETABS software. The nonlinear analysis and design of reinforced concrete shear walls is the 
exclusive subject of this paper.  

The EC8 specification is used to calculate seismic loads based on seismic mass and the acceleration 
of the largest earthquake to have occurred in Nigeria. Because the structure will pick a load period that 
is close to its natural period during the earthquake, a seismic analysis must adequately account for the 
dynamic amplification of earthquake ground motions due to resonance. 

The normal way of doing this is by using a response spectrum. The analysis of the effect of an 
earthquake has two stages: 
a. Calculation of the structure's dynamic features, including its natural period or periods.  
b. A response computation specific to the load scenario in question.  

Linear analysis-based methods are frequently used. In this instance, the ductility-modified response 
spectrum is used to address non-linearity. The building's elevation Figure 4 and plan are both regular. 
The use of a planar structural model and an analogous static analysis approach is thus permitted by EC8, 
which includes estimating the building's seismic mass and self-weight, calculating base shear in the x-
direction, and calculating the distribution of lateral loads. ETABS software was then used to simulate, 
analyze, and design the impact of seismic loads on the shear wall. 

2.6. Data Collection 
The data for this design work was collected from centre of Geodesy and Geodynamic, the Federal 

government agency monitoring the trend of Earthquake in Nigeria. The Centre for Geodesy and 
Geodynamics has carried out the spot assessment, survey and investigation on the recent and past 
occurrence of earthquakes in Nigeria. The Table 1 below show available recorded magnitude of 
earthquakes that have occurred in Nigeria. 
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Table 1. Information about the previously occurred earthquake in Nigeria. 
Date Origin Time Felt Area Magnitude Probable epicentre 
1994-11-07 05:07:51 Ibadan 4.2(ms) Dan Gulbi 

2000-03-07 15:53:54 Ibadan, Akure, Abeokuta, Ijebu-Ode and Oyo 4.5(ms) Close to Okitipupa 

2009-09-11 Nil Lagos, Ibadan and Allada, Ogun state 4.4 (ms) Benin Republic    

2016-09-12 03:11:20 Kaduna state (kwoi) 3.1 (ms) Ifewara-Zungeru fault 

Source: (Centre for Geodesy and Geodynamics). 

2.7. Building and the Load 
This section describes the building under analysis, calculates the total seismic mass, and calculates 

the applied load that an earthquake would place on the structure. The house, a three-story structure that 
does not actually exist, is thought to be situated in a seismically active region of Nigeria. 

2.7.1. The Building 
Figures 3 and 4 display drawings of the building. With slabs, beams, columns, and shear walls of the 

same size and a concrete roof assumed to be monotonic, the building is a conventional RC construction. 
The shape of the wall under analysis is depicted in Figure 4, and it is assumed that only the shear wall 
provides resistance to seismic loads. 

The concrete strength of grade C30 as well as the wall thickness of 200 mm was incorporated in this 
design work. The dimensions of the building were presented in Figures 5 and 6 while the necessary 
parameters related to the building can be seen in Table 2. 

 
Figure 5. Plan View. 

 
Figure 6. The elevation. 

2.7.2. The mass of the Building 
Even though only one wall of the building is analyzed, the weight of the whole building was 

calculated to obtain the total earthquake force applied on the wall. Figure 4 shows the elevation of the 
shear wall. 
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Table 2. Design parameter. 
Parameters Values 
Building Height H = 10.2 m 
Building Width W  = 9 m 
Building Length L  = 9m 
Storey  Height  H = 3m 
Thickness of the Wall  𝑡𝑡𝑤𝑤 = 200 mm  
Length of  Shear Wall 𝑙𝑙𝑤𝑤 = 2800 mm  
Density of the Concrete  𝜌𝜌𝑐𝑐  = 25 KN/m3 
Concrete strength 𝐶𝐶𝑐𝑐 = 30 N/mm2 
Strength of reinforcement 𝐹𝐹𝑦𝑦   = 410 N/mm2  

Data 
Beam = 250 mm × 400 mm 
Slab = 180 mm 
Column = 200 mm× 500 mm 
Live load = 3 KN/m2 
Wall = 200 mm 

Live Loads on the floor = 3 × 9 × 9 = 243 KN 
EC 8 EN 1990: 2002, 6.4.34 specified 𝑄𝑄𝑘𝑘  value of 0.3 as the live load contributing to seismic Load. 

0.3 × 243 = 72.9 KN  

Seismic loads for the symmetric floors 

=   720
2

+ 720
2

 + 180 + 120
2

+ 120
2

+ 364.5 + 72.9 = 1457.4 KN  

Seismic loads for the roof  

= 720
2

+ 180 + 120
2

 + 364.5    =   964.5 KN  

Roof load                        964.5 KN 

2nd floor loads                 1457.4 KN 

1st floors load                 1457.4 KN 

Total seismic loads          3879.3 KN  

Seismic mass   =    3,873.3 ×  1000
9.81

     = 395,443.4Kg  

According to EC8:4.3.3.2.1(1) P, the lateral force method can be applied to buildings whose response 
is not affected significantly by contributions from modes of vibration that is higher than the fundamental 
mode in each principal direction. 

𝑇𝑇1 = ≤  ∑2𝑠𝑠
4𝑇𝑇𝑐𝑐                 (from equation 1)  

 

where 𝑇𝑇1 is equal to the natural vibrating period of the building 

𝑇𝑇1 = CtH¾                 (from equation 3)  

where Ct  = 0.075
�𝐴𝐴𝑐𝑐

     (from equation 4) 

Ac =∑(𝐴𝐴𝑖𝑖.(0.2+(𝑙𝑙𝑤𝑤𝑤𝑤/H).2)     (from equation 5)  

It is assumed that the building has two opposite shear wall 

Ai= 10.2 × 0.2 = 2.04 m2  

𝐴𝐴𝑐𝑐=  2 × (2.04 (0.2 +(2.8
9

)2) = 4.24 m2  
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Then Ct= 0.075
�Ac

 = 0.075
√4.24

 = 0.036 

The natural period of the building 

T1= 0.036 × 9¾ = 0.19s  

2.8. Computation of Seismic Base Shear 
Based on the information regarding the previous Earthquake in Nigeria (Table 3), the magnitude of 

earthquake ranges from 4.2 to 4.5. The maximum body magnitude of Earthquakes that have occurred in 
Nigeria is less than 5.5. EC8 provides elastic responds spectrum type 2 Figure 7 for calculation of 
horizontal spectrum accelerations for earthquake magnitude less than 5.5. However, the value of the 
following periods, soil type and ground acceleration can be obtained from Table 4.  

Table 3. Properties of structural elements. 
Element Sizes No of Members Density ( KN/𝐦𝐦𝟑𝟑) Load (KN) 

Wall 3 × 0.2× 3 20 20 720 
Beams 0.25 × 0.4 ×3 24 25   180 

Column 0.2 × 0.5 × 3 16 25 120 
Slab 0.18 × 9 × 9 1 25    364.5 

Figure 7. Recommended spectral shapes for Type 2 seismic action (Ms < 5.5) for various ground 
types. 
 

Ground type S Tb (s) Tc (s) Td(s) 
A 1 0.05 0.25 1.2 

agr= 2.5 m/s2 (spectrum type 2 EC8) 
Tb < T1 < Tc           T1 = 0.19s 
4 Tc = 4× 0.25 = 1 
T1 <4 Tc 

2.8.1. Lateral Load Force Can Be Used 
Therefore design spectral acceleration Sd(T1) =agr × S × 2.5/q       
EC8 provide behaviour factor q for uncouple walls is 3 

Sd(T1) =2.5 × 1 × 2.5/3  

=2.08 m/s2  

In accordance to EC8 4.3.3.22 the shear base force in horizontal direction 

Fb = λSd(T1).m.     From Equation     2.2  
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= 0.85×395443.4 × 2.08  =  699.14 KN  

2.8.2. Load Distributions and Moment 
EC8 allows the assumption that the deflection form is linear with respect to the distribution of base 

shear over the building's height. According to this theory, the inertia force produced at a specific storey 
is proportional to the product of the mass of the storey and its height above the base. 
From equation 6, Fk = Fb ZkMk/∑ZjMi. 

Table 4. Mode shape approximation. 
Level Height Mass ZkMk(KNm) Force(KN) 
Roof 10.20 964.50 9837.90 260.02 

2nd floor 7.20 1457.40 10493.28 277.34 
1st floor 4.20 1457.40 6121.08 161.78 

2.9. Analysis and Design Method in Accordance with ETABS (2016) 
The summary of the steps involved in running of ETABS software for shear wall modeling, analysis and  
design are presented as follows: 
1. Design Codes: The Options menu > Preferences > Shear Wall Design command is used to set the 

design code, which is one of several codes built into the ETABS design software. EC8 (2004) was 
used for the research and design of this design project.  

2. Units: Any set of consistent units can be entered into this program to construct shear walls. 
Additionally, the unit system in use is subject to change at any time. Design codes are usually based 
on a single set of units. For analysis and design, a metric unit was chosen.  

3. Defining of property: Select define menu > material properties. Add new material in the defining 
material property the concrete of C30 and steel of grade 410 kN/m2.Also define section name, load 
pattern and loads case. For this work, the size of structural components (shear wall) is taken as per 
the requirement. Table 2 shows the design parameter input into ETABS software for the analysis 
and design. 

4. Drawing of the wall as it was specified in the input data: Select draw menu > Draw shear wall. 
Choose shear wall type and add sizes of the shear wall. The modeled shear wall is as shown in 
Figure 8a–c. 

5. Assigning Supports: Using the assign menu > joint > Restraints (supports) > fixed, choose the shear 
wall base supports while maintaining the plan at the base of the structure. Assign joint loads as well. 
The seismic load along the shear wall's height is depicted in Figure 9.  

6. The model is examined following the completion of the aforementioned procedures. After choosing 
the "Analyze" menu and selecting "Check Model," the analysis was completed and any errors were 
checked.  

7. Design: Following analysis, the structural element was designed in accordance with EC8, 2004. To 
execute the shear wall design, select the Design menu > Shear Wall Design > Start Design/Check 
of Structure command.  

8. Use one of the following methods to examine the shear wall design outcomes: (a) To view design 
input and output data on the model, select the Design menu > Shear Wall Design > Display Design 
Info command. (a) To access the interactive wall design mode, right-click on a pier or while the 
design results are shown on it. Keep in mind that you can edit, replace, and view the updated design 
results instantly while in this mode. 
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(a) 

 
(b) 

 
(c) 

Figure 8 (a) Modeled RC Shear Wall. (b) RC Shear Wall Isometric View. (c) Elevation of various storey 
height RC shear wall. 

 
Figure 9. Load along the elevation of shear wall. 

3. Results and Discussion 
The results obtained from the structural modeling, analysis and design in ETABS (a finite element 

and design software) as well as the outcomes of this research on the deflection, internal forces, and 
moment generated during the analysis are presented and discussed. The design for the shear wall to resist 
the internal forces and moments due self weight and seismic loads result are also presented. Detailing of 
reinforcement provided by ETABS software also was well presented. 

3.1. Analysis of RC shear wall 
3.1.1. Analysis  

Analysis of RC shear wall is done using ETABS and the model was prepared in the ETABS. The 
analysis involves the mathematical calculations of all the forces in the structure to be designed against to 
ensure that the structure is safe. The forces in RC shear wall due to seismic load and gravity load of the 
shear wall is determine by ETABS. 
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3.1.2. Deflection Result  
No structural member may be deformed to the point that it impairs the structure's ability to perform 

and look its best. The displacement brought on by the lateral force acting on each storey level of the 
structure is the proper limit value of deflection when considering the nature of the structure for its 
serviceability limit state and deflections. The top floor will be more affected by lateral displacement than 
other storeys (see Figure 10a). Following the RC Shear wall analysis, the model's results about the wall's 
displacement are tabulated and displayed on the displacement plot in Figure 10b and 10c. 

3.1.3. Check for Allowable Deflection 
EC2: 7.4 specify the upward deflection of cantilever subjected lateral force should not exceeded  H

250
 

Max. Deflection against Earthquake allowed is given as H
250

 =  10200
250

 = 40 mm. The maximum 
displacement at the top story is 15.166 mm from Figure 7a which is lesser than the allowable deflection 
value of 40 mm. Hence, the deflection is okay. This shows that the RC shear wall is stiff enough to resist 
the seismic load. Shear walls have very high in plane stiffness that reduces its tendency to deflect. 

 
(a) 

 
(b) 

 
(c) 

Figure 10. (a) Deformed shapes due to dead and seismic loads. (b) Joint displacements due to dead and 
seismic loads. (c) Joint displacements plot due to dead and seismic. 

3.1.4. Limitation of Inter Storey Drift 
The displacement of one level in relation to another level above or below is the limit of inter-story 

drift. For buildings with non-structural elements of brittle materials attached to the structure, EC8:4.4.3.2 
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stipulated that the drift in any level could not be greater than 0.005 times the storey height.  
Height of first Storey = 4200 mm. 

0.005(h) = 0.005(4200) = 21 mm  

The maximum inter-storey drift for the first storey is 0.000913 mm as obtained from Figure 11a is 
lesser than 21 mm. This is satisfactorily ok. 

Height of 2nd and 3rd Storey = 3000 mm 

0.005(h) = 0.005(3000) = 15 mm  

The maximum inter-storey drift for the other storey is 0.002014 mm as obtained from Figure 11b 
which was lesser than 15 mm. Hence, it is ok. 

 
(a) 

 
(b) 

Figure 11. (a) Inter storey drift for the first storey (b) Inter-storey drift for the all storey. 

3.2. Moment and Shear Force Diagram 
The analysis and determination of the internal and external forces acting on a RC shear wall with 

ETABS indicates that the moment attained has the highest value at the base of the shear wall. The 
maximum value of the bending moment is 5328.52 KNm while the shear force at apex at the base of the 
RC shear wall has the estimated value of 699.14 KN. Figure 12 shows the variation of moment along the 
height of the shear wall and Figure 13 reveals the shear forces along the height of shear wall.  
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3.3. Design of RC Shear Wall 
The primary aim of design is to ensure that at no point in the structure shall the design loads exceed 

the design strengths of the materials. This is achieved by using ETABS to design the RC shear wall to 
resist loads while ensuring that the design strength of shear wall materials greater than design loads.  

3.3.1. Vertical Reinforcement (Flexural Reinforcement) 
According to EC2: Clause 9.6.1(1) (2), the minimum area of reinforcement is 0.002Ac, where Ac is 

the corresponding concrete section area. In general, where the minimum area of reinforcement controls 
the design, half of this reinforcement should be located at each face. The total area of vertical 
reinforcement provided by the ETABS software is 1400 mm2 shown in Figure 14. 

The minimum area required = 0.002Ac. 

=0.002 × 200 × 2800 = 1120 mm2  

Area provided is 1400 mm2, which is ok. 

3.3.2. Horizontal Reinforcement (Shear Reinforcement) 
Horizontal reinforcement running parallel to the faces of the wall (and to the free edges) should be 

provided and arranged at each surface between the vertical reinforcement and the nearest surface. It 
should not be less than 0.001Ac. 

= 0.001 × 200 × 3000 = 600 mm2  
The design software provided 200 mm2/m which is 600 mm2 in three metre run. 
The horizontal reinforcement provided is ok. Figure 15 shows the area provided for the horizontal 

reinforcement. The cage reinforcement and elevation detailing are shown below in Figures 16 and 17. 

Figure 12. Variation of bending moment. 

Figure 13. Variation of shear force. 
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Figure 14. Area of vertical reinforcement. 

Figure 15. Area of horizontal reinforcement. 

Figure 16. Cage reinforcement of Shear Wall. 

Figure 17. Elevation Detailing. 
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4. Conclusions  
Seismic nonlinear finite element analysis and design of shear wall external reinforced shear wall to 

earthquake loading has been carried out. The design was carried out in compliance to relevant codes of 
practice. This following can be concluded from the analysis and design of the external reinforced concrete 
shear wall:  
• The project demonstrates the capacity of the external reinforced shear wall to resist the effect of 

seismic loads.  
• It demonstrates adequate provision of reinforcement to resist internal and external forces due to 

seismic loading.  
• It also demonstrates that adequate design of shear wall can prove effective against resisting the 

effect of earthquake loading.  
This study thus predict a structural safe and reliable solution to the problem of earthquake loading.  
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